Contacting BMC Software

You can access the BMC Software website at http://www.bmc.com. From this website, you can obtain information about the company, its products, corporate offices, special events, and career opportunities.

United States and Canada

Address  
BMC SOFTWARE INC  
2101 CITYWEST BLVD  
HOUSTON TX  
77042-2827  
USA

Telephone  713 918 8800  800 841 2031
Fax  713 918 8000

Outside United States and Canada

Telephone  (01) 713 918 8800
Fax  (01) 713 918 8000

© Copyright 1999-2015 BMC Software, Inc.

Your use of this information is subject to the terms and conditions of the applicable End User License Agreement for the product and the proprietary and restricted rights notices included in this documentation. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording or otherwise, without the prior written permission of BMC Software, Inc.

BMC, BMC Software, the BMC logo, the BMC Software logo, and other BMC marks, and the tagline “Bring IT to Life” are the exclusive properties of BMC Software, Inc., or its affiliates or subsidiaries and are registered or may be registered with the U.S. Patent and Trademark Office and in other countries. All other BMC trademarks, service marks, and logos may be registered or pending registration in the U.S. or in other countries. All other trademarks or registered trademarks are the property of their respective owners.

For BMC Control-M Products that are licensed on the “per CPU – Full Capacity” unit of measurement and installed in an Amazon Web Services (“AWS”) or Microsoft Azure (“Azure”) cloud environment, a license is required for the total number of CPUs in each AWS or Azure instance upon which the Product is installed or which the Product manages, either remotely or locally. For AWS, one CPU is equivalent to one vCPU, as defined by AWS. For Azure, one CPU is equivalent to up to four Virtual Cores (as defined by Azure), rounded up to the closest multiple of four.

IBM® Tivoli® Business Service Manager, IBM Tivoli Workload Scheduler, IBM Cognos, IBM InfoSphere DataStage, IBM iSeries, IBM Websphere, and AIX® are the trademarks or registered trademarks of International Business Machines Corporation in the United States, other countries, or both.

UNIX® is the registered trademark of The Open Group in the US and other countries.

Linux is the registered trademark of Linus Torvalds.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

SAP® R/2 and SAP R/3, SAP Business Objects, and SAP NetWeaver are trademarks or registered trademarks of SAP AG in Germany and in several other countries.

Restricted rights legend
Customer support

You can obtain technical support by using the BMC Software Customer Support website or by contacting Customer Support by telephone or e-mail. To expedite your inquiry, see “Before contacting BMC.”

Support website

You can obtain technical support from BMC 24 hours a day, 7 days a week at http://www.bmc.com/support. From this website, you can:

- Read overviews about support services and programs that BMC offers
- Find the most current information about BMC products
- Search a database for issues similar to yours and possible solutions
- Order or download product documentation
- Download products and maintenance
- Report an issue or ask a question
- Subscribe to receive proactive e-mail alerts when new product notices are released
- Find worldwide BMC support center locations and contact information, including e-mail addresses, fax numbers, and telephone numbers

Support by telephone or e-mail

In the United States and Canada, if you need technical support and do not have access to the web, call 800 537 1813 or send an e-mail message to customer_support@bmc.com. (In the subject line, enter SupID:<yourSupportContractID>, such as SupID:12345). Outside the United States and Canada, contact your local support center for assistance.

Before contacting BMC

Have the following information available so that Customer Support can begin working on your issue immediately:

- Product information
  - Product name
  - Product version (release number)
  - License number and password (trial or permanent)
- Operating system and environment information
  - Machine type
  - Operating system type, version, and service pack or other maintenance level such as PUT or PTF
  - System hardware configuration
• Serial numbers
• Related software (database, application, and communication) including type, version, and service pack or maintenance level

- Sequence of events leading to the issue
- Commands and options that you used
- Messages received (and the time and date that you received them)
  - Product error messages
  - Messages from the operating system, such as file system full
  - Messages from related software

License key and password information
If you have questions about your license key or password, contact BMC as follows:

- (USA or Canada) Contact the Order Services Password Team at 800 841 2031, or send an e-mail message to ContractsPasswordAdministration@bmc.com.
- (Europe, the Middle East, and Africa) Fax your questions to EMEA Contracts Administration at +31 20 354 8702, or send an e-mail message to password@bmc.com.
- (Asia-Pacific) Contact your BMC sales representative or your local BMC office.

Third party Software
For the provisions described in the BMC License Agreement and Order related to third party products or technologies included in the BMC Product, see https://docs.bmc.com/docs/display/workloadautomation/Control-M+Workload+Automation+Documentation and click Third-party software (TPS).
# Contents

Introduction to Control-M Reporting Facility...............................................................6
Logging in to Control-M Reporting Facility .................................................................6
Verifying the database.................................................................................................7
Configuring Control-M Reporting Facility Options.....................................................7

Reports/Templates .......................................................................................................10
General reports ...........................................................................................................11
Definition Reports........................................................................................................13
Active reports ..............................................................................................................14
Batch Impact Manager reports ..................................................................................15
Forecast reports .........................................................................................................15
Audit reports ...............................................................................................................15

Report Management ....................................................................................................17
Creating reports/templates .........................................................................................17
Defining data source settings for Active reports .......................................................19
Filters panel parameters ...........................................................................................21
Adding report template .............................................................................................22
Running a report .........................................................................................................22
Editing a report template ...........................................................................................23
Deleting a report template .........................................................................................23
Copying a report template .........................................................................................24
Introduction to Control-M Reporting Facility

The Reporting Facility is a Control-M client GUI application that enables you to define templates that you can use to generate reports that provide important information about your Control-M job flow. Control-M Reporting Facility uses the Crystal Reports application to produce reports. Report files and report template files are saved locally as .rpt report files; files template and .rpt files.

Control-M Reporting Facility enables you to do the following:

- **Configure options**: Enables you to set options for the Control-M Reporting Facility by customizing the environment, viewer, formats and confirmation defaults according to your needs. For more information, see Configuring Control-M Reporting Facility Options (on page 7).

- **Verify database**: Enables you to view your connection details and verify the database. For more information, see Verifying the database (on page 7).

- **Create reports/templates**: Enables you to define templates and reports that you can use to generate reports. For more information, see Reports/Templates (on page 10).

- **Add report templates**: Enables you to create reports based on specific report templates. For more information, see Adding report template (on page 22).

- **Run reports**: Enables you to generate reports. For more information, see Running a report (on page 22).

- **Edit report templates**: Enables you to make changes and update reports. For more information, see Editing a report template (on page 23).

- **Delete report templates**: Enables you to delete report templates. For more information, see Deleting a report template (on page 23).

- **Copy report templates**: Enables you to duplicate report templates. For more information, see Copying a report template (on page 24).

You can include variables in report templates, and then supply the values for the variables when the report is generated. The report then varies depending on the values you supply. (If you are working online you supply the dynamic values using pop-up dialogs, or if you are generating the reports in batch in an Command Line Attributes/Arguments File. For more information, see emreportcli in Control-M Workload Automation Utilities).

To view a detailed Control-M Reporting Facility overview video, see (https://www.youtube.com/watch?v=OPPEinjGsFA).

Logging in to Control-M Reporting Facility

This procedure describes how to log in to Control-M Reporting Facility.

➢ To log in to Control-M Reporting Facility:

1. From the **Start** menu, select **All Programs > BMC Software Control-M 8.0.00 > Control-M Reporting Facility**.
The Control-M Reporting Facility login window appears.

2. In the User Name field, type the username that you want to use to log in to Control-M Reporting Facility.
3. In the Password field, type the password of the username.
4. From the Server drop-down list, select the GUI server that you want to connect.
5. To change the Naming Service server and select the GUI server related to that environment, do the following:
   a. Click Advanced.
   b. In the Host Name field, type the hostname where the Naming Service server is located.
   c. In the Port Number field, type the port number for the Naming Service server.
   d. Click Apply.
   e. Repeat step 4.
6. Click Login.

Verifying the database

This procedure describes how to view the connection details and verify the database.

➢ To verify the database:
1. From the Tools menu, select Connection Details.
   The Connection Details window appears.
2. View the connection details and click Verify Database to test the database.
   A confirmation message appears.
3. Click OK.
   The database is verified.

Configuring Control-M Reporting Facility Options

This procedure describes how to set options for Control-M Reporting Facility by customizing the environment, viewer, and confirmation defaults according to your needs.

➢ To configure Control-M Reporting Facility Options:
1. From the Tools menu, select Options.
   The Options window appears
2. Select the following:
   • Environment default options (on page 8)
   • Viewer default options (on page 9)
   • Confirmations default options (on page 9)
3. Click **OK**.
   The Control-M Reporting Facility options are updated.

Environment default options
The following table lists the **Environment** pane that contain several display default settings for the Control-M Reporting facility Preview window.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Display Report Tabs** | Tabs for each open report (and the Start Page) are displayed in the taskbar at the bottom of the screen (default).  
(If not checked, tabs are not displayed, but you can toggle between open reports through the Window menu option.) |
| **Use flat buttons** | Tab appearance:  
  ▪ When checked, tabs appear as separate areas on a flat bar.  
  ▪ When not checked (default), tabs are raised and distinct. |
| **Display Report Icons** | Display report icons ( ) in the report tabs in the taskbar. |
| **Close Report on Double Click** | Double-clicking the report tab closes the report. (Depending on other options, a confirmation prompt might be displayed.) |
| **Display full path in tooltips** | Full report path will be displayed in a tooltip when you pass the cursor over the tab. |
| **Display Report** | Text to appear in the tab. Valid values:  
  ▪ Filename — name of the report file  
  ▪ Title — report title (might be abbreviated) |
Viewer default options

The following table lists the **Viewer** pane that contains several display default settings for the Control-M Reporting facility Preview window.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Border</td>
<td>Display a border around the report.</td>
</tr>
<tr>
<td>Display Background Edge</td>
<td>Display a background edge between the frame and the top of the page of the report</td>
</tr>
<tr>
<td>Conceal Last Shown Fields if Truncated (Upon Generation)</td>
<td>Do not display a truncated rightmost field in the viewer (if the rightmost field would appear truncated, conceal it).</td>
</tr>
<tr>
<td>Zoom Factor: n%</td>
<td>Default Zoom Level when viewing reports. Select any one of the following levels:</td>
</tr>
<tr>
<td>Fit Page Width</td>
<td> Set a fixed percentage zoom</td>
</tr>
<tr>
<td>Fit Whole Page</td>
<td> Page width fills the screen (it might be necessary to scroll the length of the page).</td>
</tr>
<tr>
<td></td>
<td> Full page is displayed in the screen</td>
</tr>
</tbody>
</table>

Confirmations default options

The **Confirmations** pane determines which confirmation requests and warnings are displayed for various actions.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report</td>
<td>Issues a confirmation request when you refresh or close a report.</td>
</tr>
<tr>
<td>Template</td>
<td>Issues a confirmation request when you delete or copy a template.</td>
</tr>
<tr>
<td>Other</td>
<td>Issues a warning message when a password is about to expire.</td>
</tr>
</tbody>
</table>
Reports/Templates

Control-M Reporting facility provides different reports that you can generate to view specific information in your Control-M environment. You can also define your own templates according to specific criteria.

There are the following report types:

<table>
<thead>
<tr>
<th>Report type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General reports (on page 11)</td>
<td>Collects general data, for example Alerts</td>
</tr>
<tr>
<td>Definition Reports (on page 13)</td>
<td>Collects data from the planning domain</td>
</tr>
<tr>
<td>Active reports (on page 14)</td>
<td>Collects data from the Active Jobs database</td>
</tr>
<tr>
<td>Batch Impact Manager reports (on page 15)</td>
<td>Collects data for site operating BMC Batch Impact Manager</td>
</tr>
<tr>
<td>Forecast reports (on page 15)</td>
<td>Collects data for sites operating Control-M/Forecast</td>
</tr>
<tr>
<td>Audit reports (on page 15)</td>
<td>Collects custom and Workload Change Manager request auditing data.</td>
</tr>
</tbody>
</table>

For example, if you want to view information on folders starting with the letter O, you can generate a Folder Definitions report and define your criteria.

You can define templates and reports using the report wizard. The Control-M Reporting Facility provides a fixed, predefined set of report types (for example, Alerts and Audit reports), and each template or report that you define must be of one of these predefined types. When you define templates and reports, consider the following:

- If you want to run the report once, create the report definition without defining a template, as described in Creating reports/templates (on page 17).
- If you want to generate the report multiple times, you can define a report template, as described in Creating reports/templates (on page 17).

Several sample report templates are provided with the Control-M Reporting Facility during installation. When you generate sample outputs with these templates, you might be prompted to supply input parameter values.
General reports

The general report templates enable you to gather information on the following:

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alerts report</td>
<td>Lists alerts sent to the Alerts window.</td>
</tr>
</tbody>
</table>
| Users Authorization report  | Enables you to generate a report that lists the security definitions of a specific user or group. When you generate a report for a specific user, it lists the groups that user belongs to. The report lists security definitions for each user (and group) for the following items:  
  - Job actions  
  - Service actions  
  - Service definitions  
  - Privileges  
  - Displayed Jobs and Folder  
  - Job owners  
  - Scheduling Folders  
  - Calendars  
  - Global conditions  
  - Prerequisite conditions  
  - Control resources  
  - Quantitative resources |
| Workload Distribution report | Lists and includes the following counts from the day's data for each day, for each Control-M/Server:  
  - Total number of jobs and their breakdown by task type  
  - Host ID  
  - Application type  
  - The number of executions.  
The current day's figures are not included in the report. You can also generate a report in minimal mode that contains only the number of jobs per day without any additional information. |
<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extreme Peak Usage report</td>
<td>Provides (according to the user request) one of the following sets of figures for a user-specified period:</td>
</tr>
<tr>
<td></td>
<td>▪ Highest number of tasks and executions that occurred on a single day on a single Control-M/Server during that period, and their breakdown by task type, host ID, and application type.</td>
</tr>
<tr>
<td></td>
<td>▪ Lowest number of tasks and executions that occurred on a single day on a single Control-M/Server during that period, and their breakdown by task type, host ID, and application type.</td>
</tr>
<tr>
<td></td>
<td>▪ The average number of tasks and executions to occur during that period, and their breakdown by task type, host ID, and application type.</td>
</tr>
<tr>
<td></td>
<td>The report also includes summaries for the whole environment for the period, including the number of tasks and executions, by Control-M/Server.</td>
</tr>
<tr>
<td>Managed Servers report</td>
<td>Lists all computers that are either hosting the various Control-M components or are used to run Control-M jobs for a specified time period.</td>
</tr>
<tr>
<td></td>
<td>For each host, the report provides details of the computer's number of CPUs, CPU type, OS type, and version. Additionally, a summary is included in the report, which counts the number of hosts for each combination of number of CPUs plus CPU type.</td>
</tr>
<tr>
<td></td>
<td>The summary in the Managed Servers report shows all nodes that are relevant to the specified time frame, so multiple details per node might appear for multiple reports. Each node has a time frame that is part of a whole period.</td>
</tr>
</tbody>
</table>
Definition Reports

The definition report templates enable you to gather information on the following:

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Job Definitions report</strong></td>
<td>Lists all jobs and job details determined by selection and display criteria.</td>
</tr>
<tr>
<td></td>
<td>It also includes a count of the number of jobs contained in the report.</td>
</tr>
<tr>
<td></td>
<td>Note that in the case of multiple jobs, these can be from the same or different folders or SMART Folders.</td>
</tr>
<tr>
<td><strong>Folder Definitions report</strong></td>
<td>Lists all folders and folder details determined by selection and display criteria.</td>
</tr>
<tr>
<td><strong>Links Definition report</strong></td>
<td>Shows the links (dependencies) defined between all jobs or between selected jobs, as determined by selection and display criteria. Global conditions are also included in this report. For example, you can list all the dependencies and global conditions that are defined in a specific data center, or only those defined between two groups.</td>
</tr>
<tr>
<td><strong>Manual Definitions report</strong></td>
<td>Performs validity checks and lists any IN condition that is not defined as an OUT condition of another job. Though manual conditions normally have no corresponding OUT conditions, the listed conditions might nevertheless reveal omissions and spelling errors.</td>
</tr>
</tbody>
</table>
Active reports

The active report templates enable you to gather information on the following:

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Active Jobs report</strong></td>
<td>Lists all jobs and job details determined by selection and display criteria. It also includes a count of the number of jobs contained in the report. Note that multiple jobs having the same name can be in the same or different folders.</td>
</tr>
<tr>
<td><strong>Prerequisite Conditions report</strong></td>
<td>Lists conditions according to selection and display criteria. This report is also called the Conditions report. The report is similar to the information displayed in the Prerequisites tab of Control-M Workload Automation. For more information, see In Conditions.</td>
</tr>
<tr>
<td><strong>Control Resources report</strong></td>
<td>Lists control resources and their attributes according to selection and display criteria. The information in the report is similar to the information displayed in Control resources in Control-M Workload Automation.</td>
</tr>
<tr>
<td><strong>Quantitative Resources report</strong></td>
<td>Lists quantitative resources and their attributes according to selection and display criteria. The report is similar to the information displayed in Quantitative resources in Control-M Workload Automation.</td>
</tr>
<tr>
<td><strong>Active Links report</strong></td>
<td>Shows the links (dependencies) defined between all jobs or between selected jobs, as determined by selection and display criteria. Global conditions are also included in this report. For example, you can list all the dependencies and global conditions that are defined in a specific data center, or only those defined between two groups.</td>
</tr>
<tr>
<td><strong>Active Manual report</strong></td>
<td>Performs validity checks and lists the In conditions in each active job that do not also appear as added OUT conditions in another active job. Although such conditions normally reflect manual conditions, they can also reflect omitted Out conditions, or misspelled In or Out conditions.</td>
</tr>
</tbody>
</table>
Batch Impact Manager reports

The BIM report templates enable you to gather information on the following:

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLA Analysis report</td>
<td>Displays the number of executions that ended for a specified service, for a specified period of time as follows:</td>
</tr>
<tr>
<td></td>
<td>- Ended on time</td>
</tr>
<tr>
<td></td>
<td>- Ended late</td>
</tr>
<tr>
<td></td>
<td>- Did not complete execution</td>
</tr>
<tr>
<td>History report</td>
<td>Lists which services executed, when they executed, and the execution completion status for a specified period of time.</td>
</tr>
<tr>
<td>Detailed Business Service report</td>
<td>Provides a summary that includes the service name, date, completion status and related job details for a specific service execution.</td>
</tr>
<tr>
<td>Service–Jobs report</td>
<td>Lists its associated jobs in the Active Jobs database for a selected BIM service. (This BIM report is an Active report type.)</td>
</tr>
<tr>
<td>Jobs–Service report</td>
<td>Lists its associated BIM services in the Active Jobs database for a selected job. (This BIM report is an Active report type.)</td>
</tr>
</tbody>
</table>

Forecast reports

The Forecast report templates enable you to gather information on the following:

- **Workload report**: Lists the total number and names of jobs that ran during a specific time frame. The output is produced in both graphic and table formats.

- **Trend Analysis report**: Lists the number of jobs that started during a specific time period in history, such as the first week of every month, or the last day of every week.

- **Jobs Execution report**: Lists the jobs with information, such as start time, end time, and average run time. You can group job execution information by time segment.

The Forecast Analysis set of reports are available only if you purchased other BMC Software Add-ons, such as Control-M/Forecast. (Only administrators can run Control-M/Forecast reports).

Audit reports

The Audit report templates enable you to gather information on the following:
\textbf{Custom Audit:} Lists the results of auditing Control-M/EM server for operations of a selected audit type. For example, changes in job and calendar definitions can be tracked.

\textbf{WCM Request:} Lists the following results of auditing Workload Change manager request workspaces determined by selection and display criteria in the report template. This enables you to review changes that are done in a request and to audit when and what changes are requested and by which user.

- Add Content Workspace
- Add Job/Folder Definition
- Check in Workspace
- Check out Workspace
- Delete Job/Folder Definition
- Delete Workspace (cancel Check Out)
- Local Folder Delete
- Return Request Workspace
- Submit Request Workspace
- Take Requester Workspace Ownership
- Take Workspace Ownership
- Update Folder
- Update Job/Folder Definition
- Write Folder
- Write New Folder

The workspace must be checked-in for the report data to be available.

To create a new Audit report/template, see \textit{Creating reports/templates} (on page 17).
Report Management

You can manage reports by performing the following procedures:

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create reports/templates</td>
<td>Enables you to define templates and reports that you can use to generate reports. For more information, see Reports/Templates (on page 10).</td>
</tr>
<tr>
<td>Add report templates</td>
<td>Enables you to create reports based on specific report templates. For more information, see Adding report template (on page 22).</td>
</tr>
<tr>
<td>Run reports</td>
<td>Enables you to generate reports. For more information, see Running a report (on page 22)</td>
</tr>
<tr>
<td>Edit report templates</td>
<td>Enables you to make changes and update reports. For more information, see Editing a report template (on page 23).</td>
</tr>
<tr>
<td>Delete report templates</td>
<td>Enables you to delete report templates. For more information, see Deleting a report template (on page 23).</td>
</tr>
<tr>
<td>Copy report templates</td>
<td>Enables you to duplicate report templates. For more information, see Copying a report template (on page 24).</td>
</tr>
</tbody>
</table>

Creating reports/templates

The following procedure describes how to create new reports/templates that enable you to generate a report to gather specific information or to create your own template defined with your required settings to use for reports that you expect to run more than once.

➢ To create reports/templates:
1. From the Control-M Reporting Facility toolbar, select one of the following:
   - to create a new report
   - to create a new template

2. In the left pane, select the report category.
3. In the right, select the report type.
4. For a template, type a name for the template in the **Template Name** field.

5. Click **OK**.

   The report wizard appears.

6. In the **General** pane do the following:
   a. In the **Report Title** field, type a name for the report.
   b. In the **Created by** field, type the name of the user.
   c. In the **Description** field, type a description if required.

7. Click **Next**.

   The **Filter** pane appears. If you are defining a new report/ template for Active report types the Data Source panel appears. For more information, see Defining data source settings for Active reports (on page 19).

8. In the **Filter** panel, define the required parameters, as described in Filters panel parameters (on page 21).

9. Click **Next**.

   The **Fields** panel appears.

10. In the **Fields** panel, do the following:
    a. From the All Fields list, select the field you want to appear in the report.
    b. Click .
    c. Repeat for all fields you want to add to the report.
    d. To remove a field, click .

11. Click **Next**.

   The **Grouping** Panel appears. If you are creating a WCM Request report, continue to the **Summaries** panel.

12. In the **Grouping** panel, do the following:
    a. From the left fields' list, select the field you want to the report rows to be group by.
    b. Click .
    c. Repeat for all fields you want to add to the report.
    d. To remove a field, click .

13. Click **Next**.

   The **Summaries** panel appears.

14. In the **Summaries** panel, do the following:
    a. From the **Summary by field** drop-down list, select the field you want to display a summary of all its record.
    b. To display the summaries in a chart, select the **Show Chart** check box.
c. In the **Chart Title** field, type a name for the Chart.
d. Select a chart type.

15. Click **Next**.

   The **Sorting** panel appears.

16. In the **Sorting** panel, do the following:
   
a. In the **Sort By** drop-down list, select the field to sort columns in the report, and click whether the sort should be in ascending or descending order.

   b. Repeat the process for the second and third sort fields from the **Then By** drop-down lists.

17. Click **Next**.

   The **Style** panel appears.

18. Select the style of the report.

   The **Report Details** panel appears.

19. In the **Report Details** panel, do the following:
   
a. Review your report details.

   b. Select the **Save report as template** check box if required.

   c. In the **Template Name** field, type the name of the template.

20. Click **Finish**.

   The report preview appears.

21. Save the report by clicking ![save button] or save as template by clicking ![template save button].

   The report/template is created.

---

### Defining data source settings for Active reports

This procedure describes how to define data source settings for Active reports which enables you to define which Control-M/Server the report data is taken.

- **To define data source settings for Active reports:**

1. From the left Control-M/Servers list, select the Control-M/Server you want to use as your data source.

2. Click ![link button].

3. Repeat for all Control-M/Servers you want to add to the report.

4. Do the following:
   
a. To remove a Control-M/Server, click ![remove button].

   b. To add a mask, which enables you to exclude specific Control-M servers that you do not want to view in the report, do the following:

   a. Select a Control-M/Server.
b. Click Add Mask.

The **Add Control-M Server Name Mask** window appears.

c. Type a name for the mask using * and ? wildcards.

5. From the Load report data from the following network field, select from one of the following:

   - **Current Active Network**: Enables you to view jobs that are currently running.
   - **Latest Archived Network**: Enables you to view the latest job run.
   - ** Archived Network from the selected date**: Enables you to select a specific date and view jobs that were running on that date.

6. Click **Next**.

   The **Filters** panel appears. For more information, see **Filters panel parameters** (on page 21).
Filters panel parameters

The following table lists the Filters panel parameters.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Name</td>
<td>Defines the field to use for filtering data</td>
</tr>
<tr>
<td>Param</td>
<td>Specifies that the value to be used for filtering on the field should be dynamically specified when the report is run</td>
</tr>
<tr>
<td>Operator</td>
<td>Defines the operator (for example, = or &gt;) to use with the value specified in the Value/Param Name field</td>
</tr>
</tbody>
</table>
| Value/Param Name          | Defines the parameter name to be used to prompt you for a value at run time. The Value/Param Name field allows you to specify * and ? wildcards, the ! symbol for Not logic, and the , symbol for Or logic.  
<pre><code>                       | Note: If you specify wildcard or special logic symbols in the Value/Param Name field, you must set the operator to LIKE (or these symbols will be treated as literals). |
</code></pre>
<p>| Fix                       | Enables you to save any entries that you want to appear in the panel the next time you create a new report or template of this type |
| Time Filter               | Filters the data according to time criteria                                  |
| Last number of days       | Filters data in the defined last number of days                              |
| From date/To date         | Filters data according to the defined specific dates                         |
| From time/To time         | Filters data according to the defined specific times                         |
| Each week day             | Filters data according to the defined specific week day                      |
| Each month day            | Filters data according to the defined specific month day                     |
| Entity Type               | Filters the data according to entity type                                    |
| Produce Global links report| Produces a report on dependencies between jobs on all of the different Control-M servers |
| Display                   | Defines how the data is displayed in the report                             |
| Required data             | Filters data according to Maximum/Minimum/Average number of jobs loaded on a single day |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audit Type</td>
<td>Defines the type of Audit data to retrieve</td>
</tr>
<tr>
<td>Audit Operation</td>
<td>Specifies which audit action to view in the report</td>
</tr>
<tr>
<td>Service Name</td>
<td>Name of the BIM service to view in the report</td>
</tr>
<tr>
<td>Job Name</td>
<td>Name of the job service to view in the report</td>
</tr>
<tr>
<td>Show final state only</td>
<td>Shows only the final state of the service in the report and not all the states the service was in during its' life cycle</td>
</tr>
<tr>
<td>Date</td>
<td>Filters data to show only today's data, yesterday's data, or a specific date</td>
</tr>
</tbody>
</table>

Adding report template

This procedure describes how to add a new report template which enables you to create a new report based on a predefined template.

➢ **To add a report template:**

1. From the Reporting Facility Start Page, in the left pane, select the report type to create.
   The report type pane appears on the right.

2. Select ‑.
   The Report Template Name window appears.

3. Type the name of the template.

4. Click OK.
   The report wizard appears.

5. Define the report settings as described in Creating reports/templates (on page 17).

6. Click Finish.
   The report preview appears.

7. Save the report by clicking ‑ or save as template by clicking ‑.
   The report is created.

Running a report

This procedure describes how to run a report which enables you to generate containing the information you defined in the report template.
To run a report:
1. From the Reporting Facility Start Page, in the left pane, select the report type to run.
   The report type pane appears on the right.
2. Click .
   The report preview appears.
3. Save the report by clicking , or save as template by clicking .
   The report is generated.

Editing a report template
This procedure describes how to edit a report template which enables you to update existing report templates.

To edit a report template:
1. From the Reporting Facility Start Page, in the left pane, select the report type to edit.
   The report type pane appears on the right.
2. Click .
   The report wizard appears with the relevant report information.
3. Edit the required information.
4. Click Finish.
   The report preview appears.
5. Save the report by clicking , or save as template by clicking .
   The report template is updated.

Deleting a report template
This procedure describes how to delete a report template which enables you to remove a report.

To delete a report template:
1. From the Reporting Facility Start Page, in the left pane, select the report type to delete.
   The report type pane appears on the right.
2. Click .
   A confirmation message appears.
3. Click Yes.
   The report template is deleted.
Copying a report template

This procedure describes how to copy a report template which enables you to duplicate a report with all the defined information.

➢ To copy a report template:

1. From the Reporting Facility Start Page, in the left pane, select the report type to copy.
   The report type pane appears on the right.
2. Click 📖.
   A confirmation message appears.
3. Click Yes.
   The Copy Report Template window appears.
4. Type the report template name.
5. Click OK.
   The report is copied and appears in the pane.